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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan

pengguna sebelum menggunakan monitor. Panduan

tersebut berisi informasi dan catatan penting
tentang cara mengoperasikan monitor:

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan

tanggal pembelian, nama dealer, nomor model, dan

nomor produksi produk.

1.1 Tindakan pencegahan dan pemeliharaan

(A Peringatan
Penggunaan kontrol, penyesuaian, maupun

prosedur selain yang dijelaskan dalam dokumentasi

ini dapat mengakibatkan sengatan listrik, bahaya
listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer:

Pengoperasian

* Jauhkan monitor dari sinar matahari langsung,
sinar terang yang sangat kuat dan jauhkan dari

sumber panas lainnya. Terpapar ke lingkungan
seperti ini dalam waktu yang lama dapat
mengakibatkan monitor memucat dan rusak.
* Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.
* Jangan halangi lubang ventilasi pada kabinet.
* Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.
* Jika mematikan monitor dengan melepaskan

kabel daya atau kabel daya DC, tunggu selama

6 detik sebelum memasang kabel daya atau
kabel daya DC untuk pengoperasian biasa.

Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak
ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya selama
pengoperasian berlangsung.

Jaga agar monitor tidak terjatuh atau terbentur
selama pengoperasian atau pengiriman.

Pemeliharaan

Untuk melindungi monitor dari kemungkinan
kerusakan, jangan tekan panel monitor telalu
keras. Saat memindahkan monitor, pegang
bingkai untuk mengangkat, jangan angkat
monitor dengan meletakkan tangan atau jari
pada panel monitor.
Lepas sambungan monitor jika Anda tidak akan
menggunakannya dalam waktu lama.
Lepas sambungan monitor jika Anda akan
membersihkannya dengan kain yang lembab.
Layar dapat dibersihkan dengan kain yang
kering saat dimatikan. Namun, jangan pernah
gunakan larutan organik, seperti alkohol
atau cairan beramonia untuk membersihkan
monitor.
Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air, maupun
berada dalam lingkungan dengan kelembaban
berlebihan.
Jika monitor basah, segera seka dengan kain
kering.
Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas kabel
daya. Setelah itu, keluarkan benda asing atau
air tersebut, lalu bawa ke pusat pemeliharaan.
Jangan simpan atau gunakan monitor di lokasi
yang bersuhu panas, terkena sinar matahari
langsung, atau bersuhu sangat dingin.
Untuk memelihara performa terbaik monitor
dan memperpanjang masa pakainya, gunakan
monitor di lokasi dalam kisaran suhu dan
kelembaban berikut.

o Suhu: 0-40°C 32-95°F

o Kelembaban: 20-80% RH



*  PENTING: Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala jika
monitor akan menampilkan konten statis yang
tidak berubah. Tampilan gambar diam atau
gambar statis yang tidak berubah dalam waktu
lama dapat menimbulkan “efek terbakar”,
disebut juga “jejak gambar” atau “bayangan”, di
layar.

*  "Efek terbakar","jejak gambar", atau "bayangan”
adalah fenomena umum dalam teknologi panel
monitor. Dalam sebagian besar kasus, ‘efek
terbakar”, “jejak gambar', atau “bayangan” akan
menghilang secara bertahap dalam waktu
tertentu setelah daya dimatikan.

() Peringatan

Gejala “efek terbakar”,"jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di atas
tidak tercakup dalam jaminan.

Layanan

*  Penutup casing hanya dapat dibuka oleh teknisi
ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

*  Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

€ Catatan

Hubungi teknisi servis jika monitor tidak beroperasi
secara normal atau Anda tidak yakin dengan
prosedur yang harus dilakukan bila petunjuk
pengoperasian yang diberikan telah diikuti.

1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian, atau
peringatan yang digunakan sebagai berikut:

© Catatan

lkon ini menunjukkan informasi penting dan tips
yang akan membantu Anda memanfaatkan sistem
komputer dengan lebih baik.

@ Perhatian

lkon ini- menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

(D Peringatan

lkon ini menunjukkan kemungkinan cedera

dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam format
lain dan mungkin tidak disertai dengan ikon. Dalam
hal ini, penulisan peringatan tertentu diwajibkan
oleh peraturan pemerintah terkait.



1.3 Pembuangan produk dan materi kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit www.philips.com/about/sustainability/recycling.




2. Pegang dudukan dasar monitor dengan kedua

2. Memasang monitor tangan dan masukkan dudukan dasar dengan
kuat ke dalam batang dudukan.

2.1 Pemasangan (1) Pelan-pelan pasang alas ke kolom alas
sampai kunci mengunci alas.

(2) Kencangkan sekrup yang terletak di dasar
alas dengan jari, dan eratkan alas ke kolom
kuat-kuat.

El Isi kemasan

5 ==
Start

PHILPS

—— 9

VGA (optional) DVI (optional)

Bl Memasang dudukan dasar

1. Letakkan monitor menghadap ke bawah pada
permukaan yang halus dan lembut agar layar
tidak tergores atau rusak.




El Menyambungkan ke PC 2.2 Mengoperasikan monitor

PHILIPS

[1] o e
r“m [ ==
\, o SIE
g —_—
© Input daya AC -
© InputVGA
© IhputDVID El Keterangan produk bagian depan
o Kunci antipencurian Kensington
P ¢ 197E3L
Menyambung ke PC Py
1. Sambungkan kabel daya dengan kuat ke /v ©/A /4 /0K 0}
bagian belakang monitor. | | [\ | |
2. Matikan komputer dan lepas kabel daya. o e o6 o o
3. Sambungkgn kabgl sin?/al monitor ke 197E3L (untuk model 1A)
konektor video di bagian belakang
komputer: (5]
4.  Sambungkan kabel daya komputer dan
monitor ke stopkontak di sekitar: @|7" T/ 4 ‘l)/ ‘\ @i o (ll)
5. Hldulpkan kompu‘Fer dan momtor.Jlkal P o 00 o 0
monitor menampilkan gambar, berarti

pemasangan telah selesal Untuk menghidupkan dan mematikan

daya monitor.

&)/0OK |Untuk mengakses menu OSD.

Kembali ke tingkat OSD sebelumnya.

Mengganti format tampilan.

Menyesuaikan tingkat kecerahan.

<
i)
O
A 'V Untuk menyesuaikan menu OSD.
©
()]

Untuk mengubah sumber input
sinyal.

Mengganti format tampilan.

Smartimage Lite. Ada tiga mode
yang dapat dipilih: Standard

e e (Standar), Internet, dan Game

(Permainan).




El Keterangan On Screen Display Menu OSD

Apakah yang dimaksud dengan OSD (On-Screen  Berikut adalah tampilan keseluruhan dari struktur

Display)? On-Screen Display. Anda dapat menggunakannya
sebagai referensi bila ingin melakukan penyesuaian
OSD (On-Screen Display) adalah fitur yang lainnya nanti.

terdapat pada semua monitor Philips. Pengguna

akhir dapat menggunakannya untuk menyesuaikan
performa layar atau memilih fungsi monitor . C VGA
secara langsung melalui jendela petunjuk di DVI (available for selective models)
layar. Antarmuka tampilan di layar yang mudah

Main menu Sub menu

| 1A A Picture Format — Wide Screen, 4:3
digunakan muncul seperti di bawah ini: | Picture
Brightness — 0~100
197E3L Contrast — 0~100
SmartContrast — On, Off
VGA r
<5 Input P Color Temperature —— 6500K, 9300K
DvI |— Color
sRGB
Picture -
: User Define Red: 0~100
E Green: 0~100
Blue: 0~100
|— Language — English, Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuii, &3, Tirkge

r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
{— Transparency — Off1,2,3,4
— OSD Time out — 55,105,205,305,60s
Ricture Format : '— Setup — Auto
EhiTES L 10 t— H. Posicion — o~100
Contrast . 50
= IR — V. Posicon — o100
SmartContrast . Off
— Phase — 0~100
Language - . [— Clock — 0~100
_ -~ — Resolution Notification — On, Off
0SD Settings "
— Reset — Yes,No
L Information

Setup

Petunjuk dasar dan mudah pada tombol kontrol

Dalam OSD yang ditunjukkan di atas, pengguna
dapat menekan tombol w A di bezel depan
monitor untuk memindahkan kursor, OK untuk
mengkonfirmasi pilihan atau perubahan.



El Pemberitahuan resolusi 2.3 Melepas Dudukan dan Dudukan Dasar

Monitor dirancang untuk memberikan performa Bl Melepas Dudukan Dasar

optimal pada resolusi aslinya, 1366 x768@60Hz. Sebelum mulai membongkar penyangga monitor,
Bila monitor dihidupkan pada resolusi yang ikuti petunjuk di bawah ini agar terhindar dari
berbeda, layar akan menampilkan peringatan: kerusakan atau cedera.

Gunakan 1366x768@60Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat 1. Letakkan monitor menghadap ke bawah pada
dinonaktifkan dari Setup (Konfigurasi) dalam menu permukaan yang halus agar layar tidak tergores
OSD (On Screen Display). atau rusak.

Bl Fungsi Fisik

Kemiringan

2. Lepaskan penyangga alas dari kolom alas dengan:

(1) Melonggarkan sekrup yang terletak di
dasar alas dengan jari.

(2) Pelan-pelan menggerakkan naik dan turun
untuk melepas kunci yang mengunci alas
dan menarik alas dari kolom alas.




E1 Melepas dudukan

1.

Anda dapat menggunakan obeng minus untuk
menancapkan ke dua lubang pelepasan pada
penutup engsel dan pelan-pelan bongkar
penutup tersebut untuk melepasnya.




3. Pengoptimalan Gambar

3.1 Smartlmage Lite

El Apakah yang dimaksud dengan
SmartContrast?

Smartlmage Lite memberikan preset yang
mengoptimalkan layar untuk berbagai jenis konten
dengan menyesuaikan kecerahan, kontras, warna,
serta ketajaman secara real time dan dinamis.
Meskipun Anda bekerja dengan aplikasi teks,
menampilkan gambar, atau menonton video, Philips
Smartlmage Lite memberikan performa monitor
yang dioptimalkan.

El Mengapa saya memerlukannya?

Anda memerlukan monitor yang memberikan
tampilan semua jenis konten favorit yang
dioptimalkan. Perangkat lunak Smartimage Lite
akan menyesuaikan kecerahan, kontras, warna,
serta ketajaman secara real time dan dinamis
untuk menyempurnakan pengalaman tampilan
monitor Anda.

E Bagaimana prosedurnya?

Smartimage Lite merupakan teknologi eksklusif
dan canggih dari Philips yang menganalisis konten
yang ditampilkan di layar. Berdasarkan skenario
yang dipilih, Smartimage Lite menyempurnakan
kontras, saturasi warna, dan ketajaman gambar
secara dinamis untuk menyempurnakan konten
yang sedang ditampilkan. Semua dapat dilakukan
secara real time dengan menekan satu tombol.

3 Bagaimana cara mengaktifkan Smartlmage
Lite?

D,

PHIIPS

-

1. Tekan B untuk mengaktifkan Smartlmage
Lite di layar;

2. Tekan terus B untuk beralih di antara
Standard (Standar), Internet, dan Game
(Permainan).

3. Tampilan Smartlmage Lite akan tetap muncul
di layar selama 5 detik atau Anda juga dapat
menekan “OK" untuk mengkonfirmasi.

4. Bila Smartlmage Lite diaktifkan, skema
sRGB akan dinonaktifkan secara otomatis.
Untuk menggunakan sRGB, Anda harus
menonaktifkan Smartlmage Lite dengan
tombol B} di bezel depan monitor.

Selain menggunakan tombol B untuk menggulir
ke bawah, Anda juga dapat menekan tombol

v A untuk memilih, lalu menekan “OK" untuk
mengkonfirmasi pilihan dan menutup OSD
Smartimage Lite.



Ada tiga mode yang dapat dipilih: Standard
(Standar), Internet, dan Game (Permainan).

@ SmartImage "™

Standard

Internet

Game

Standard (Standar): Menyempurnakan teks dan
mengurangi kecerahan untuk meningkatkan
kemampuan baca serta mengurangi kelelahan
pada mata. Mode ini secara nyata akan
menyempurnakan kemampuan baca dan
produktivitas saat Anda bekerja dengan
spreadsheet, file PDF, artikel yang dipindai, atau
aplikasi kantor umum lainnya.

Internet: Profil ini menggabungkan saturasi
warna, kontras dinamis, dan penyempurnaan
ketajaman untuk menampilkan foto dan
gambar lain dengan kejernihan yang luar biasa
dalam warna yang menarik. Semua dilakukan
tanpa memerlukan alat bantu lain dan tanpa
adanya warna yang pudar.

Game (Permainan): Mengaktifkan sirkuit drive
untuk waktu respons terbaik, menghilangkan
tepi bergerigi untuk objek yang bergerak
cepat di layar, serta meningkatkan rasio
kontras untuk skema terang dan gelap. Profil
ini memberikan pengalaman terbaik bagi
penggemar permainan dalam menjalankan
permainan.

3.2 SmartContrast

El Apakah yang dimaksud dengan
SmartContrast?

Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor untuk
kejernihan visual dan kenyamanan tampilan
maksimal dengan menambah cahaya lampu latar
agar gambar lebih jernih, tajam, dan terang, atau
mengurangi cahaya lampu latar untuk tampilan
gambar yang jelas di latar belakang gelap.

B3 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap jenis
konten. SmartContrast secara dinamis mengontrol
kontras dan menyesuaikan cahaya lampu latar agar
gambar dalam permainan serta video lebih jernih,
tajam, dan terang, atau menampilkan teks yang jelas
dan mudah dibaca untuk pekerjaan kantor. Dengan
mengurangi pemakaian daya monitor; Anda
menghemat biaya untuk daya dan memperpanjang
masa pakai monitor:

El Bagaimana prosedurnya?

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time untuk
menyesuaikan warna dan mengontrol intensitas
cahaya lampu latar. Fungsi ini akan secara dinamis
menyempurnakan kontras untuk pengalaman
hiburan yang luar biasa saat menonton video atau
menjalankan permainan.



3.3 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol monitor
melalui antarmuka grafis layar yang mudah
digunakan. Penyesuaian rumit sebelumnya kini
tidak ada lagi karena panduan perangkat lunak
yang mudah digunakan ini akan memandu Anda
menyesuaikan resolusi penyempurnaan, Kalibrasi
warna, Pengaturan jam/fase, Pengaturan titik putih
RGB, dsb.

Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis lkon animasi yang
menarik dan mendukung Windows 7 ini siap

menyempurnakan pengalaman Anda menggunakan

monitor Philips!
El Penginstalan

* lkuti petunjuk dan selesaikan penginstalan.

* Anda dapat mengaktifkannya setelah
penginstalan selesai.

» Jika ingin mengaktifkannya di lain waktu, Anda
dapat mengklik cara pintas di desktop atau
toolbar.

PHILIPS

www philips.com/welcome
Monitor driver and software installation

Syem recur

+ PC running Windows 7, Vs, XP, 200,98

Philps SmareControl

Sysom sppor

suppore Windows . Vises, XP.

3 s Monkor Plog and Pay support.

11

Wizard pengaktifan pertama kali

* Setelah penginstalan SmartControl Lite selesali,
Wizard pengaktifan pertama kali akan terbuka
secara otomatis.

*  Wizard ini akan memandu Anda menyesuaikan
performa monitor secara bertahap.

*  Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

* Anda dapat menyesuaikan pilihan lainnya tanpa
menggunakan wizard melalui panel Standard
(Standar) .

8 SmartControl 2 - Philips 22581 (CS30715000001) ()X,

SmartControl Lite PHILIPS

Wizard

Adiust Audio

U

Color e

€

Options Presats

4

=
Help

Start Waard



E1 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

* Menu Adjust (Penyesuaian) digunakan untuk
menyesuaikan Brightness (Kecerahan),
Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

* Anda dapat mengikuti petunjuk dan melakukan

penyesuaian.

» Cancel (Batal) mengkonfirmasi pengguna jika
ingin membatalkan penginstalan.

8 smartcontrol

SmartControl Lite

()

£
g
&

%

ad

Contrast:

Color oy

el

o Focus

=5 b
\g Postion
Options

Resolution

®

Help

8 smartControl

SmartControl Lite

]

Adijust
Brightness
\g Contrast.
Color ~
a3
- Fous
5
\g postin
Options
Resokton

®

Help

2- Philps 22581 (CS30715000001) \2)(X
PHILIPS

Brightness

Improperly adjusted Brightness wil resut n 3 loss of
detal n darker image areas. Adjust the Brightness for
the best possible picture qu
the Brightness to the minfum
e Brightness to the dested vel,
Adjust the Brightness as needed to achieve
an equal separation of the strpes.

1
2

Brightness 100

&

]

undo Reset

2 phips 22581 (cs30715000001) (2] X
PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais in
ighter image areas.
1. Raise the Contrast unti the numbers 1 and 2

should remain barely vible

Contrast 50

-+

undo Reset

8 smartContol

SmartControl Lite

]

Adjust

optons

L3

Help

8 smartControl

Brightness

Contrast

B

Focus

Postion

w

Resolution

SmartControl Lite

Adjust

i

Color

€

Options

®

Help

8 smartcontrol

Brghtness

Contrast.

Focus

Resolution

SmartControl Lite

Adjust

U

Color

Options

®

Help

Brghtness

Contrast.

)

Focus

2 - Philps 22581 (C530715000001) (%)X,
PHILIPS

Focus

\’nurmsmav‘s('mng needs to be synchronized with
the video

1 Chunse Auto Setup.

2 I the vetal bance e s veble,you need

to adjust the Pi

Pitch: Try to make the vertical bands dsappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

picch

g

Phase

_ Undo _ AutoSetwp

2. phips 22581 (cs30715000001) (2] X
PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can posicon the image

p, down, left, or righ

1. Use the Up/Down buttons to center the image
vertical

2. Use the Left/Right buttons to center the mage
hortontaly.

Undo Reset

2 Philps 22581 (CS30715000001) {#)X

PHILIPS

Resolution

You are currently at 3 Preferred resolution. For your
disply to show crisp, clear text, colors, and images,
your dispiay shoud be set to s Preferred resolution.
If your disply i at 2 Non-Preferred resolution, cick
on the Preferred button to change your resolution to

I™ Enable Resokution Notifer

Picture Format.
I 4:3 aspect ratio




Menu Color (Warna): BT 2. prios 25 (cswrisonon) 3%
»  Menu Color (Warna) digunakan untuk SmartControl Lite PHILIPS
menyesuaikan RGB, Black Level (Tingkat Display Gamma
Hitam), White Point (Titik Putih), Color it

Calibration (Kalibrasi Warna), dan Smartimage \ R —
Lite (Lihat bagian Smartlmage Lite). pomd " e

i 1. Use the sider to select the desred Gamma.

* Anda dapat mengikuti petunjuk dan melakukan / N
penyesuaian. \g
B . Color. White Paint Display Gamma 22
*  Untuk item submenu berdasarkan input Anda, - = .
linat tabel di bawah ini. e o e
L

* Misalnya Color Calibration (Kalibrasi Warna). Optons ot nde

ap
W smartControl 2- Philps 22581 (CS30715000001) {F](X) Smartimage

SmartControl Lite PHILIPS iz

RGB

All displayed colors are produced by mixing Red, Blue,
and Green at different brightness levels. Choosing a
etz White Pont wi gve you optinel RGB. ' you
prefer to adjust the RGB now, folow thess steps: = smaronmor
1. Adjust the intensity of the Red, Green, and
e using the sidr b, ”
& NOTE: Crangng the RG8 vakes con acversely efect SmartControl Lite PHILIPS
GB.

the displayed colors.

2 Pnaps 22581 (CS3U/15000001) (LI

]

Adiust
Calibration

Biack Level = + Your display needs to

0 produce the w

Calibration shou

step i the proces
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! Undo Reset.

o v III Finaly, press Start to begin the calibration
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¥ Enable color calibration
Color
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B SmartControl 2- Philps 22581 (€530715000001) (%)
X Help
SmartControl Lite PHILIPS  showme s

Quick View
White Point

White Point is the paint at which equal combinations

"Show Me" (Tunjukkan) memulai tutorial
" Pess st he e oo e s kalibrasi warna.

il o 2. Start (Mulai) - memulai urutan kalibrasi

. warna 6 langkah.

3. QuickView (Tampilan Ringkas) memuat

i

‘Whie Point
—— gambar sebelum/sesudah kalibrasi.
Display Gamma = - & .
P 4. Untuk kembali ke panel awal Color (Warna),

‘*"&P ) i klik tombol Cancel (Batal).

srrirge 5. Enable color calibration (Aktifkan kalibrasi
= warna) - telah diaktifkan secara default. Jika
tidak dicentang, kalibrasi warna tidak dapat
dijalankan serta tombol mulai dan tampilan
ringkas akan dinonaktifkan.

6. Info paten harus ditampilkan di layar kalibrasi.

&€ §ﬁ
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Layar Kalibrasi warna pertama:

Tombol Previous (Sebelumnya) dinonaktifkan
hingga layar kalibrasi warna kedua ditampilkan.
Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

Layar terakhir menampilkan panel File>Presets
(File>Preset).

Cancel (Batal) menutup antarmuka pengguna
dan kembali ke halaman plug in.

Smartlmage Lite
Memungkinkan pengguna mengubah pengaturan
layar menjadi lebih baik berdasarkan konten.

Bila Entertainment (Hiburan) ditetapkan,
SmartContrast dan SmartResponse akan
diaktiflan.

8 smantContol 2%

SmartControl Lite PHILIPS

SmartImage

]

RGB

Black Level

Adiust

White Pont.

Display Gamma

g4

-y
Options Calibration
&
\Q s"[ﬁrme =
Help —
o 1]

Internet Standard
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Options>Preferences (Pilihan>Preferensi) -
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options
(Pilihan). Di layar yang tidak didukung, namun
dilengkapi DDC/CI, hanya tab Help (Bantuan) dan
Options (Pilihan) yang tersedia.

8 SmartControl 2 Philps 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

Preferences

Adjust

Menampilkan pengaturan preferensi saat ini.
Jika kotak dicentang, fitur akan diaktifkan. Kotak
centang berfungsi sebagai pengunci.

Enable Context Menu (Aktifkan Menu
Konteks) di desktop dicentang (Aktif) secara
default. Enable Context Menu (Aktifkan Menu
Konteks) menampilkan pilihan Select Preset
(Pilih Preset) dan Tune Display (Sempurnakan
Layar) untuk SmartControl Lite dalam menu
konteks klik kanan di desktop. Disabled
(Dinonaktifkan) menghapus SmartControl Lite
dari menu konteks klik kanan tersebut.

lkon Enable Task Tray (Aktifkan Baki Tugas)
dicentang (Aktif) secara default. Aktifkan

menu konteks menampilkan menu baki tugas
untuk SmartControl Lite. Mengklik kanan

ikon baki tugas akan menampilkan pilihan
menu Help (Bantuan), Technical Support
(Dukungan Teknis), Check for Update (Periksa
Pembaruan), About (Tentang), dan Exit
(Keluar). Bila Enable task tray menu (Aktifkan
menu baki tugas) dinonaktifkan, ikon baki tugas
hanya akan menampilkan EXIT (KELUAR).



* Run at Startup (Jalankan Saat Pengaktifan) Options>Audio (Pilihan>Audio) - Hanya

dicentang (Aktif) secara default. Bila diaktifkan sewaktu memilih Audio dari menu drop-
dinonaktifkan, SmartControl Lite tidak akan down Options (Pilihan).
berjalan saat pengaktifan atau tidak akan Di layar yang tidak didukung, namun dilengkapi

ditampilkan dalam baki tugas. Satu-satunya cara  DDC/CI, hanya tab Help (Bantuan) dan Options
menjalankan SmartControl Lite adalah melalui  (Pilihan) yang tersedia.
cara pintas desktop atau file program. Preset e o e iR
apapun vang ditetapkan untuk berjalan saat e e PHILIPS
pengaktifan tidak akan dimuat bila kotak ini
tidak dicentang (Dinonaktifkan).

» Enable transparency mode (Aktifkan mode

Audio

the integrated loudspeakers by

ted loudspeakers by checking the

transparansi) (Windows 7,Vista, XP). Nilai \Q 0 " e
default adalah 0% Tidak Tembus Cahaya. il w:
Options>Input (Pilihan>Input) - Hanya diaktifkan \g ‘p
sewaktu memilih Input dari menu drop-down . k
Options (Pilihan). Di layar yang tidak didukung, =
namun dilengkapi DDC/CI, hanya tab Help i s
(Bantuan) dan Options (Pilihan) yang tersedia. \ o ..
Semua tab SmartControl Lite lainnya tidak = 100
tersedia. - ; ’
W smartconol 2-phips 22581 (cs30715000001) (7]
SmartControl Lite PHILIPS

Adiust Audo

\g uto Pro
Color Tnput

= b

ward

a

B
Options. Presets
Y w

Analog In Digial In

*  Menampilkan panel petunjuk Source (Sumber)
dan pengaturan sumber input saat ini.

* Dilayar input tunggal, panel ini tidak akan
ditampilkan.
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Help>User Manual (Bantuan>Panduan Pengguna)
- Hanya diaktifkan sewaktu memilih User Manual
(Panduan Pengguna) dari menu drop-down Help
(Bantuan). Di layar yang tidak didukung, namun
dilengkapi DDC/CI, hanya tab Help (Bantuan) dan
Options (Pilihan) yang tersedia.

B smartControl 2 - Philps 22581 (CS30715000001) |2\ X

SmartControl Lite PHILIPS

User Manual

Adiust

a
(i ®
Color ‘“
\
i »
\ Version
=
Help

User Manual Tech. Support

Help>Version (Bantuan>Versi) - Hanya diaktifkan
sewaktu memilih Version (Versi) dari menu drop-
down Help (Bantuan). Di layar yang tidak didukung,
namun dilengkapi DDC/CI, hanya tab Help
(Bantuan) dan Options (Pilihan) yang tersedia.

B smartControl 2.- Philps 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

Version

ION dtune-plp-R2009-12-17-

Adiust

User Manua
@
[ ®
Update
Color a
) Disply ID
\L iy System 1D
Options. z
o
A Verson

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuai Konteks)
diaktifkan secara default. Jika Enable Context Menu
(Aktifkan Menu Konteks) telah dicentang dalam
panel Options>Preferences (Pilihan>Preferensi),
menu tersebut akan ditampilkan.

g SmartControl
Select Preset 13
Tune Display

Menu Konteks memiliki empat entri:

*  SmartControl Lite - Bila dipilih, About Screen
(Tentang Layar) akan ditampilkan.

*  Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu.Tanda centang
menunjukkan preset yang saat ini dipilih. Preset
Pabrik juga dapat dipilih dari menu drop down.

» Tune Display (Sempurnakan Layar) - Membuka
panel kontrol SmartControl Lite.

Smartlmage Lite - Memeriksa pengaturan saat
ini, seperti Standard (Standar), Internet, dan
Game (Permainan).



Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.

Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

* Help (Bantuan) - Mengakses file User Manual
(Panduan Pengguna): Buka file User Manual
(Panduan Pengguna) menggunakan jendela
browser default.

* Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.

*  Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

* About (Tentang) - Menampilkan informasi rinci
tentang referensi: versi produk, informasi edisi,
dan nama produk.

»  Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan ulang
sistem.

PHILIPS

SmartControl

‘SmartControl
‘Version 3.20
dtune-standard-R2007-01-04-11 5123
Copyright 1983-2007 Portrait Displays, Inc.
Patents Pending

Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas, nonaktifkan
Run at Startup (Jalankan Saat Pengaktifan) dalam
Options>Preferences (Pilihan>Preferensi).
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4. Spesifikasi Teknis

Jenis panel monitor LCDTFT

Lampu latar LED

Ukuran panel 18,5" (47,0 cm)

Rasio aspek 16:9

Jarak Piksel 0,3x0,3 mm

Kecerahan 250 cd/m?

SmartContrast 20.000.000:1

Rasio kontras (biasa) 1000:1

Waktu respons (biasa) 5ms

Resolusi Optimum 1366x768 @ 60Hz

Sudut pandang 170° (H)/160° (V) @C/R>10

Penyempurnaan Gambar Smartlmage Lite

Warna layar 16,7 M

Kecepatan refresh vertikal 56Hz-76Hz

Frekuensi Horizontal 31kHz - 83kHz

sRGB YA

Input sinyal DVI-D (digital), VGA (Analog)

Sinyal Input Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

Kenyamanan Pengguna 197E3L: /v /A 0/« /0K d)
19783L (A /v ma/a /4 ook (D

Bahasa OSD Inggris, Prancis, Jerman, ltalia, Rusia, Spanyol, China Modern,
Portugis, Turki

Kenyamanan lainnya Kunci Kensington

Kompatibilitas Plug & Play DDC/CI, sRGB, Windows 7, Mac OSX, Linux

Kemiringan -5/+20
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Mode Aktif

12.91W (biasa), 13,59W (maks.)

Pemakaian Daya

Tegangan Input Tegangan Input

Tegangan Input

(Metode pengujian AC pada 100VAC AC pada 115VAC AC pada 230VAC

EnergyStar 5.0) +/-5VAC, 50Hz +/- +/-5VAC, 50Hz +/- | +/-5VAC, 50Hz +/-
5Hz S5Hz 5Hz

Pengoperasian Normal 10,05W 9,96W 9.97W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0,5W

Penghilangan Panas*

Tegangan Input
AC pada T00VAC AC pada 115VAC
+/-5VAC, 50Hz +/- | +/-5VAC, 50Hz +/-
5Hz S5Hz

Tegangan Input

Tegangan Input
AC pada 230VAC
+/-5VAC, 50Hz +/-
5Hz

Pengoperasian Normal

30,304 BTU/jam 34,008 BTU/jam

34,024 BTU/jam

Tidur (Siaga) 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Tidak Aktif 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Produk dengan dudukan (PxLxT)

462 x 364 x 200 mm

Produk tanpa dudukan (PxLxT)

462 x 295 x 41 mm

Kisaran suhu (beroperasi)

Produk dengan dudukan 2,63 kg
Produk tanpa dudukan 2,194 kg
Produk dengan kemasan 3,724 kg

0°C hingga 40°C

Kisaran suhu (tidak beroperasi)

-20°C hingga 60°C

Kelembaban relatif

20% hingga 80%

Ketinggian beroperasi: + 12.000 kaki (3.658 m)
tidak beroperasi: + 40.000 kaki (12.192 m)
MTBF 30.000 jam
[ Lngwrgn ]
ROHS YA
EPEAT Perak. (www.epeat.net)
Kemasan 100% dapat didaur ulang
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Pengesahan Peraturan Tanda CE, FCC Kelas B, GOAST, SEMKO, TCO Certified,
UL/cUL, BSMI, 1ISO9241-307, Energy star 5.0

Warna Hitam (belakang)/Biru (depan)
Lapisan Luar Mengkilap
© Catatan

1. EPEAT Emas atau Perak hanya berlaku di lokasi tempat produk Philips terdaftar. Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi
terbaru, kunjungi www.philips.com/support.
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4.1 Mode Resolusi & Preset

El Resolusi Maksimum

Untuk 197E3L
1366 x 768 pada 60 Hz (input analog)
1366 x 768 pada 60 Hz (input digital)

E1 Resolusi yang Disarankan

Untuk 197E3L
1366 x 768 pada 60 Hz (input digital)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
47,71 1366 x 768 59,79
© Catatan

Perhatikan bahwa tampilan berfungsi dengan paling

baik pada resolusi aslinya yaitu 1366 x 768 @60Hz.

Untuk kualitas tampilan terbaik, ikuti resolusi yang
rekomendasi ini.
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5.Manajemen Daya

5.1 Hemat Daya Otomatis

Jika PC dilengkapi perangkat lunak yang terinstal
atau kartu tampilan yang terpasang sesuai dengan
DPMVESA, monitor secara otomatis dapat
mengurangi pemakaian daya saat tidak digunakan.
Jika terdapat input dari keyboard, mouse, atau
perangkat input lainnya yang terdeteksi, monitor
akan 'bangun' secara otomatis. Tabel berikut
menunjukkan pemakaian daya dan pemberian
sinyal dari fitur hemat daya otomatis ini:

197E3L
Mode | Video |Sinkronisasi| Sinkronisasi Daya yang Warna
VESA horizontal vertikal Digunakan LED
Aktif | AKTIF Ya Ya <1291W (biasa)|  Putih
Tidur | TIDAK Tidak Tidak <05W Putih
(Siaga) | AKTIF (berkedip)
Matikan | TIDAK - - <05W TIDAK
AKTIF AKTIF

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor:

Resolusi asli: 1366 x 768

Kontras: 50%

Kecerahan: 250 nit

Suhu warna: 6.500k dengan pola putih sepenuhnya

© Catatan

Informasi ini dapat berubah tanpa pemberitahuan
sebelumnya.
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6. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance
with European community’s stringent RoHs
directive mandating restrictions on hazardous
substances in electrical and electronic equipment
have been adhered to in order to make Philips
monitors safe to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!
CERTIFIED
is designed, manufactured and
tested according to some of the
strictest quality and environmental requirements
in the world. This makes for a high performance
product, designed with the user in focus that also
minimizes the impact on the climate and our
natural environment.

The display you have just purchased
carries the TCO Certified label.
This ensures that your display

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast, resolution,
black level, gamma curve, colour and luminance
uniformity and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

* Very low energy consumption both in on- and

standby mode minimize climate impact

Restrictions on chlorinated and brominated

flame retardants, plasticizers, plastics and heavy

metals such as cadmium, mercury and lead

(RoHS compliance)

* Both product and product packaging is prepared
for recycling

* The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.



EPEAT
(Wwww.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
z’b

X

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration
(www.energystargov)

ENERGY STAR

As an ENERGY STAR® Partner,

we have determined that this
product meets the ENERGY STAR®
guidelines for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques

de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont congues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, I'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre I'équipement et
le récepteur.

*  Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
*  Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A devics on tha specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection wp to 30 meters). The usar of tha
devics is obliged to take all staps necessary to remove sources of intarference 1o tela-
communication or other devicas.

Polkud nani na typovém &tfthu polftade uvedeno, #= spadé do do tfidy A podie EN 55022,
do thidy B podle EN 55022, Pro zafizen! zatazend do tidy A {chranné
30m) podie EN 56022 plati ndsledujici. Dojde-li k ruien! tslekomunikadnich nebo

Fnych zafizeni je ufivatel povinnen provést takovd opatfgnl, aby rueni odstranil,




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor; printer; and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

HEZBERERIRE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Riickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften Uber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
SEAROHS

REPEAR (RTHESSRISHEHSIENE) (BIAPEARRHS) »
RS SIE T A SRR R AN E S SRS ANERINE B

FREH LR
E7# (HAMCRT)

geforderten Werten entspricht, ist darauf zu HEGENESTE
achten, dai3
1. Reparaturen nur durch Fachpersonal 25 HELEOEHTE
durchgefuhrt werden.
2. nur original-Ersatzteile verwendet werden. AL E | & | one | sumx | sacam
. . - . . =l ¥
3. bei Ersatz der Bildrohre nur eine bauartgleiche = 5 T o o 5 5 o
| i CRTBT * o] o (o] [e] o]
eingebaut wird. SEmemEE = = = = =
[ ol ] [e] &) [S] [e]
RRER ol [s] [¢] &) [S] [e]
Aus ergonomischen Griinden wird empfohlen,| HH#a#s | = | O | O o s ©
die Grundfarben Blau und Rot nicht auf dunklem| | 2'# ;ﬁ%sgizg%ﬁﬁgggaﬁﬁ%gis *f :ﬂ% s
. T B T B R AR R A SRR E R T
Untergrund zu verwenden (schlechte Lesbarkeit X ETEASRUNREOTROOE SRR
™ . . I=. B B T "%
und erhohte Augenbelastung bei zu geringem TASERS SHAER (RFRRAW)

Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

A)

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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7.Layanan pelanggan dan
jaminan

7.1 Kebijakan Cacat Piksel Monitor Panel Datar
Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel monitor TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindari. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuai
dengan jaminan yang berlaku. Pemberitahuan

ini menjelaskan berbagai jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel monitor TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah cacat
subpiksel pada monitor tidak boleh lebih dari
0,0004%. Philips bahkan selanjutnya menentukan
standar kualitas lebih tinggi untuk jenis atau
kombinasi cacat piksel tertentu yang lebih nyata
dibandingkan dengan yang lainnya. Kebijakan ini
berlaku secara global.

subpixel subpixel

v
il &

Piksel dan Subpiksel

Piksel, atau elemen gambar; terdiri dari tiga
subpiksel dalam warna utama merah, hijau, dan
biru. Kombinasi beberapa piksel akan membentuk
gambar: Bila semua subpiksel pada piksel menyala,
kombinasi ketiga subpiksel berwarna tersebut akan
muncul sebagai satu piksel putih. Bila semua mati,
kombinasi ketiga subpiksel berwarna akan muncul

subpixel

sebagai satu piksel hitam. Kombinasi lainnya dari
subpiksel yang menyala dan mati akan muncul
sebagai satu piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan
pola gelap. Berikut adalah jenis cacat titik terang:

Satu subpiksel merah, hijau, atau biru terang

I C

Dua subpiksel terang yang berdekatan:
- Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

Tiga subpiksel terang yang berdekatan (satu piksel
putih)
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€& Catatan

Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih terang

daripada titik di sekitarnya. .

Cacat Titik Gelap

Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,
titik gelap merupakan subpiksel yang terlihat jelas ~ Jarak Cacat Piksel

di layar bila monitor menampilkan pola terang. Karena cacat piksel dan subpiksel sejenis yang

Berikut adalah jenis cacat titik gelap: saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak cacat

piksel.

I Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel monitor TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

CACAT TITIKTERANG TINGKAT YANG DAPAT DITERIMA

1 subpiksel terang 3

2 subpiksel terang yang berdekatan 1

3 subpiksel terang yang berdekatan (satu piksel putih) 0

Jarak di antara dua cacat titik terang* >15mm

Total cacat titik terang dari semua jenis 3

1 subpiksel gelap 5 atau lebih sedikit

2 subpiksel gelap yang berdekatan 2 atau lebih sedikit

3 subpiksel gelap yang berdekatan 0

Jarak di antara dua cacat titik gelap* >15mm

Total cacat titik gelap dari semua jenis 5 atau lebih sedikit

TOTAL CACAT TITIK TINGKAT YANG DAPAT DITERIMA

Total cacat titik terang atau titik gelap dari semua jenis 5 atau lebih sedikit
© Catatan

1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
Monitor ini sesuai dengan ISO 9241-307. (1I509241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)
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7.2 Layanan pelanggan dan jaminan

Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs Web www.philips.com/support. Anda ju ga dapat menghubungi nomor Pusat

Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara ASC Nomor layanan konsumen  Harga
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0.09
Germany Siemens &S +49 01803 386 853 € 0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €010
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Sweden A-novo +46 08 632 0016 Local call tariff

United Kingdom

Invec Scotland

+44 0207 949 0069

Local call tariff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Negara Pusat informasi ~ ASC Nomor layanan konsumen
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware ‘ +36 12426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
woroa fegro NA Kim Tec doo. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
i NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara Pusat informasi Nomor layanan konsumen
Argentina Vermont 0800 3330 856
Brazil Vermont 0800-7254101

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi ~ ASC Nomor layanan konsumen
Canada Supercom Supercom (800) 479-6696
USA. TOS Teleplan (877) 835-1838

Informasi kontak untuk China:

China

Nomor layanan konsumen: 4008 800 008




Informasi kontak untuk kawasan APMEA:

Negara Pusat informasi ASC Nomor layanan konsumen
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
s Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | \y_ -\ Tel. (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
. . . ‘ . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea [ NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d.|str|butor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab o AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
. . +84 8 38248007 Ho Chi Minh City
Vietham NA FPT Service Informatic +84 5113562666 Danang City

Company Ltd.

+84 5113.562666 Can tho Province
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8. Mengatasi masalah & Tanya
jawab

8.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus berlanjut
setelah Anda mencoba solusi berikut, hubungi staf
layanan pelanggan Philips.

E Masalah Umum

Tidak Ada Gambar (LED Daya mati)

*  Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.
Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi
OFF (TIDAK AKTIF), lalu tekan ke posisi ON
(AKTIF).

Tidak Ada Gambar (LED Daya Putih)

*  Pastikan komputer telah dihidupkan.

Pastikan kabel sinyal telah tersambung dengan
benar ke komputer.

Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

Pastikan kabel monitor telah tersambung
dengan benar ke komputer: (Lihat juga
Panduan Ringkas).

Periksa pin yang tertekuk pada kabel monitor.
Pastikan komputer telah dihidupkan.
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Tombol AUTO (OTOMATIS) tidak berfungsi

* Fungsi otomatis hanya berlaku dalam mode
Analog VGA. Jika hasilnya tidak memuaskan,
Anda dapat melakukan penyesuaian manual
melalui menu OSD.

© Catatan
Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan api

* Jangan lakukan langkah-langkah apapun untuk
mengatasi masalah

Lepaskan segera monitor dari catu daya utama
untuk keselamatan

Hubungi segera staf layanan pelanggan Philips.

El Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)

di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.

Gambar bergetar di layar
» Pastikan kabel sinyal telah tersambung dengan

benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.
Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.



Kelip horizontal muncul di layar

*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

*  Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan"

tetap muncul setelah daya dimatikan.

* Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama dapat
menimbulkan “efek terbakar”, disebut juga
“jejak gambar'” atau “bayangan”, di layar. "Efek

terbakar", "jejak gambar", atau "bayangan”

adalah fenomena umum dalam teknologi panel

monitor. Dalam sebagian besar kasus, “‘efek

terbakar”, "jejak gambar’, atau “‘bayangan” akan

menghilang secara bertahap dalam waktu
tertentu setelah daya dimatikan.

* Aktifkan selalu program screensaver bergerak
bila Anda meninggalkan monitor.

» Aktifkan selalu aplikasi refresh layar berkala jika

Monitor akan menampilkan konten statis yang
tidak berubah.

*  Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
jaminan.

Gambar tampak berubah. Teks tidak jelas atau

buram.

*  Atur resolusi layar PC ke mode sama seperti
resolusi asli layar yang disarankan monitor.
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Titik hijau, merah, biru, hitam, dan putih muncul

di layar

» Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
dalam teknologi saat ini. Untuk informasi lebih
rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan

mengganggu

* Anda dapat mengatur lampu "daya hidup”
menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat
Informasi Konsumen dan hubungi staf layanan
pelanggan Philips.



8.2 Tanya Jawab SmartControl Lite

P1.

Jawab:

P2.

Jawab:

P3.

Jawab:

Saya mengganti monitor PC dan
SmartControl Lite menjadi tidak dapat
digunakan.Apa yang harus saya lakukan?

Hidupkan ulang PC dan lihat apakah
SmartControl Lite dapat berfungsi. Jika
tidak, hapus dan instal ulang SmartControl
Lite untuk memastikan driver yang benar
telah diinstal.

SmartControl Lite berfungsi dengan baik
sebelumnya, namun kini tidak lagi. Apa
yang dapat saya lakukan?

Jika tindakan berikut dilakukan, driver
monitor mungkin perlu diinstal ulang.
Mengganti adapter grafis video
Memperbarui driver video

Aktivitas pada OS, misalnya service pack
atau patch

Jalankan Windows Update serta driver
monitor dan/atau video yang diperbarui
Boot di Windows dijalankan dengan
monitor dalam kondisi mati atau tidak
tersambung. Untuk mengetahuinya, klik
kanan My Computer (Komputer Saya),
lalu klik Properties->Hardware-> Device
Manager (Properti->Perangkat
Keras->Manajer Perangkat). Jika "Plug and
Play Monitor" (Monitor Plug and Play)
ditampilkan dalam Monitor; Anda harus
menginstal ulang. Hapus dan instal ulang
SmartControl Lite.

Setelah menginstal SmartControl Lite, bila
tab SmartControl Lite diklik, layar tidak
menampilkan apapun setelah beberapa
saat atau layar menampilkan pesan
kegagalan. Mengapa demikian?

Adapter grafis mungkin tidak kompatibel
dengan SmartControl Lite. Jika adapter
grafis adalah salah satu merek yang
disebutkan di atas, coba download driver
adapter grafis terbaru dari situs Web

P4,

Jawab:

PS.

Jawab:
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perusahaan yang terkait. Instal driver. Hapus
SmartControl Lite, lalu instal ulang sekali
lagi.

Jika tetap tidak berfungsi, kami mohon
maaf bahwa adapter grafis tersebut tidak
didukung. Kunjungi situs Web Philips dan
lihat apakah driver SmartControl Lite
terbaru telah tersedia.

Bila saya mengklik Product Information
(Informasi Produk), hanya sebagian
informasi yang ditampilkan. Mengapa
demikian?

Driver adapter kartu grafis mungkin bukan
merupakan versi terbaru yang sepenuhnya
mendukung antarmuka DDC/CI. Coba
download driver adapter grafis terbaru dari
situs Web perusahaan yang terkait. Instal
driver. Hapus SmartControl Lite, lalu instal
ulang sekali lagi.

Attention

Theft Deterence enabled

Saya lupa PIN untuk Fungsi Theft
Deterrence (Pencegahan Pencurian).Apa
yang dapat saya lakukan?

Pusat Layanan Philips berhak meminta
identifikasi dan otorisasi resmi untuk
menetapkan kepemilikan monitor.

Perlu diketahui bahwa fungsi pencegahan
antipencurian diberikan sebagai pilihan
yang bebas dan mudah. Mengelola nomor
PIN adalah sepenuhnya tanggung jawab
pengguna, baik perorangan maupun
organisasi, yang membuatnya.

Jika lupa nomor PIN, pusat layanan

Philips dapat membuat ulang PIN untuk
Anda dengan membebankan sejumlah
biaya setelah verifikasi kepemilikan. Perlu
diketahui bahwa aktivitas ini tidak tercakup
dalam persyaratan jaminan standar.



8.3 Tanya Jawab Umum

P1:

Jawab:

P2:

Jawab:

P3:

Sewaktu memasang monitor, apa yang
harus saya lakukan jika layar menampilkan
"Cannot display this video mode" (Tidak
dapat menampilkan mode video ini)?

Resolusi yang disarankan untuk monitor ini:
1366 x 768 @60Hz.

Lepas semua kabel, lalu sambungkan PC ke
monitor yang digunakan sebelumnya.
Dalam Windows Start Menu (Menu

Mulai Windows), pilih Settings/Control
Panel(Pengaturan/Panel Kontrol) . Dalam
Control Panel Window (Jendela Panel
Kontrol), pilih ikon Display (Tampilan).
Dalam Display Control Panel (Panel
Kontrol Tampilan), pilih tab "Settings"
(Pengaturan). Dalam tab pengaturan,
dalam kotak "desktop area" (area desktop),
gerakkan panel samping ke piksel 1366 x
768.

Buka "Advanced Properties" (Properti
Lanjutan), atur Kecepatan Refresh ke 60Hz,
lalu klik OK.

Hidupkan ulang komputer, lalu ulangi
langkah 2 dan 3 untuk memverifikasi bahwa
PC telah diatur ke 1366 x 768 @60Hz.
Matikan komputer; lepas monitor lama, lalu
sambungkan monitor Philips.

Hidupkan monitor, lalu hidupkan PC.

Berapa kecepatan refresh yang disarankan
untuk Monitor?

Kecepatan refresh yang disarankan untuk
Monitor adalah 60Hz. Jika terdapat
gangguan di layar, Anda dapat mengaturnya
hingga 75Hz untuk mengetahui apakah
gangguan tersebut dapat diatasi.

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM? Bagaimana cara
menginstal driver (.inf dan .icm)?

Jawab:

P4:

Jawab:

P5:

Jawab:

Pé:

Jawab:

P7:

Jawab:
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Ini adalah file driver untuk monitor. Untuk
menginstal driver, ikuti petunjuk dalam
panduan pengguna. Komputer mungkin
akan menanyakan driver monitor (file

.inf dan .icm) atau disk driver saat Anda
menginstal monitor untuk pertama kalinya.
lkuti petunjuk tentang cara memasukkan
CD-ROM pendamping yang disertakan
dalam kemasan ini. Driver monitor (file .inf
dan .icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi yang
diinginkan dalam Panel Kontrol Windows®
dengan “Display properties” (Properti
tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK,; lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali semua
pengaturan pabrik awal.

Apakah layar monitor antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara membersihkan
permukaan monitor?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol, aseton,
hexane, dll.



P8:  Apakah pengaturan warna pada monitor
dapat diubah?

Jawab: Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesuai
prosedur berikut,

* Tekan "OK" untuk menampilkan menu
OSD (On Screen Display)

* Tekan "Down Arrow" (Panah Bawah) untuk
menggunakan pilihan "Color" (Warna), lalu
tekan "OK" untuk membuka pengaturan
warna. Berikut adalah tiga pengaturan yang
tersedia.

1. Temperatur warna; 2 setelannya adalah
6500K, dan 9300K.

2. sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran warna
yang benar di antara berbagai perangkat
(misalnya kamera digital, monitor, printer,
pemindai, dll.)

3. User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesuai keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

€ Catatan:

Penghitungan warna lampu yang dipancarkan
oleh benda tertentu sewaktu sedang
dipanaskan. Penghitungan ini diberikan dalam
persyaratan skala absolut, (derajat Kelvin).
Suhu Kelvin lebih rendah seperti 2004K
berwarna merah; suhu lebih tinggi seperti
9300K berwarna biru. Suhu netral adalah putih
pada 6504K.

P9:  Apakah Monitor dapat disambungkan ke
PC manapun, workstation, atau Mac?

Jawab: Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.

P10:  Apakah Monitor Philips memiliki fungsi

Plug-and-Play?

Jawab: Ya. Monitor merupakan perangkat Plug-
and-Play yang kompatibel dengan Windows
7/Vista/XP/NT, Mac OSX; Linux

P11: Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,

atau Bayangan pada panel monitor?

Jawab: Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan "efek terbakar", disebut
juga "jejak gambar" atau "bayangan", di
layar: "Efek terbakar”, "jejak gambar", atau
"bayangan" adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, "efek terbakar", "jejak gambar”,
atau "bayangan" akan menghilang secara
bertahap dalam waktu tertentu setelah
daya dimatikan.

Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten
statis yang tidak berubah.

() Peringatan

Gejala "efek terbakar”, "jejak gambar", atau
"bayangan" yang fatal tidak akan hilang dan
tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
jaminan.

P12: Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter

bergerigi?

Jawab: Monitor berfungsi paling baik pada resolusi
asli 1366 x 768 @60Hz. Untuk tampilan
terbaik, gunakan resolusi ini.
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